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GETTING STARTED GUIDE

PXIe-5164
PXIe, 400 MHz, 1 GS/s, 14-bit PXI Oscilloscope

Note  Before you begin, install and configure your chassis and controller.

This document explains how to install, configure, and test the PXIe-5164. The PXIe-5164 is a
1 GS/s reconfigurable oscilloscope with a user-programmable FPGA.

To access PXIe-5164 documentation, navigate to Start»All Programs»National
Instruments»Reconfigurable Oscilloscopes»Reconfigurable Oscilloscopes Documentation
or Start»All Programs»National Instruments»NI-SCOPE»NI-SCOPE Documentation.
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Verifying the System Requirements
To use the LabVIEW Instrument Design Libraries for Reconfigurable Oscilloscopes
instrument driver, your system must meet certain requirements.

Refer to the product readme, which is available on the driver software media or online at 
ni.com/manuals, for more information about minimum system requirements, recommended
system, and supported application development environments (ADEs).

Unpacking the Kit
Refer to the following figure to identify the contents of the PXIe-5164 kit.

Figure 1. PXIe-5164 Kit Contents

1 3 42

16-Bit IF Digitizer

N
I PX

Ie-5164

1. PXIe-5164

2. PXIe-5164 Safety, Environmental, and Regulatory

Information

3. PXIe-5164 Getting Started Guide (this document)

4. Maintain Forced-Air Cooling Note to Users

Notice  To prevent electrostatic discharge (ESD) from damaging the module,
ground yourself using a grounding strap or by holding a grounded object, such as
your computer chassis.

1. Touch the antistatic package to a metal part of the computer chassis.
2. Remove the module from the package and inspect it for loose components or other signs

of damage.

Notice  Never touch the exposed pins of connectors.

Note  Do not install a module if it appears damaged in any way.

3. Unpack any other items and documentation from the kit.

Store the module in the antistatic package when the module is not in use.
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Other Equipment
There are several required items not included in your device kit that you need to operate the
PXIe-5164. Your application may require additional items not included in your kit to install or
operate your device.

Required Items

• A PXI Express chassis and chassis documentation
• A PXI Controller or PC with a Device for PXI Remote Control system that meets the

system requirements specified in this guide and chassis documentation

Optional Items

• PXI Slot Blocker Kit, 5 slot blockers (NI part number 199198-01)
• PXI Filler Panel Kit, 17 filler panels (NI part number 778646-01)
• BNC-to-BNC cable, 50 Ω, 1 m (NI part number 781887-01)
• AUX 0 connectivity:

– SCB-19 noise rejecting, shielded AUX 0 connector block (NI part number
783959-01)

– SHH19-MH19-AUX shielded single-ended cable, 1 m (NI part number 784091-01)
– Mini-HDMI Breakout Cable to 6 BNC, 6 in. (NI part number 786979-01)

• Oscilloscope probe compensator, SMB (NI part number 786983-01)
• Probes—refer to the following table for several options compatible with the PXIe-5164.

Table 1. Probe Options for the PXIe-5164

Model NI Part Number Description

   CP400X 784254-01 400 MHz, 2 m, 10X cable divider probe

CP500X 784253-01 500 MHz, 1.2 m, 10X cable divider probe

NI 5191 781785-01 800 MHz differential active probe

SA1000X 784255-01 1 GHz single-ended active probe

SA1500X 784256-01 1.5 GHz single-ended active probe

SA2500X 784257-01 2.5 GHz single-ended active probe

SP500C 783630-01 100x passive probe, 500 MHz

SP500X 783629-01 10x passive probe, 500 MHz

CC0550X 786846-01 5 A RMS, 50 MHz current probe

CC05120X 786847-01 5 A RMS, 120 MHz current probe
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Table 1. Probe Options for the PXIe-5164 (Continued)

Model NI Part Number Description

   CC5002X 786848-01 500 A RMS, 2 MHz current probe

CC15010X 786849-01 150 A RMS, 10 MHz current probe

CC3050X 785561-01 30 A RMS, 50 MHz current probe

CC30100X 785562-01 30 A RMS, 100 MHz current probe

Visit ni.com for more information about these additional items.

Preparing the Environment
Ensure that the environment in which you are using the PXIe-5164 meets the following
specifications.

Temperature

Operating 0 °C to 50 °C

Storage -40 °C to 71 °C

Humidity

Operating 10% to 90%, noncondensing

Storage 5% to 95%, noncondensing

Pollution Degree 2

Maximum altitude 4,600 m (570 mbar) (at 25 °C ambient temperature)

Indoor use only.

Choosing the Software

Software Options
NI provides multiple software options for interacting with the PXIe-5164: InstrumentStudio,
NI-SCOPE instrument driver software, and the instrument design libraries.
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Table 2.  PXIe-5164 Software Options

Use Case Software Option

  Acquire and analyze data without
programming

InstrumentStudio (first available in NI-SCOPE 18.1;
64-bit systems only)

Create custom measurements and
automation applications

NI-SCOPE instrument driver

Note  You can also use NI-SCOPE
instrument driver FPGA extensions to
customize the device using precompiled
bitfiles while maintaining the functionality
of the NI-SCOPE instrument driver.

Customize the behavior of the
device FPGA to create application-
specific instrument designs

Instrument design libraries along with the LabVIEW
FPGA Module

Note  You can use a combination of these software options for your application.
However, when using the NI-SCOPE driver and the instrument design libraries in a
single application, only one option can access the device at a time.

Related Information

Installing the Software on page 6

http://digital.ni.com/express.nsf/bycode/IDLintro

http://www.ni.com/labview/fpga/

Comparison of Software Features
NI-SCOPE instrument driver software and the instrument design libraries vary in the features
they support.

Table 3. Comparison of Software Features

Feature NI-SCOPE Instrument Design Libraries

   Customization of onboard
FPGA

Yes, using the
instrument driver
FPGA extensions

Yes, using the LabVIEW FPGA
Module

Source availability Closed source Open source

LabVIEW support Yes Yes
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Table 3. Comparison of Software Features (Continued)

Feature NI-SCOPE Instrument Design Libraries

   C/C++/C# support Yes Yes—using the LabVIEW
Application Builder Module, you
can compile LabVIEW code into
custom DLLs for use with other
application development
environments (ADEs).

InstrumentStudio support Yes No

LabVIEW examples or sample
projects

Yes Yes

Installing the Software
Close all programs before installing the software. You must install the software before
installing the PXIe-5164.

Install your software in the following order:
1. Install the latest service packs for your operating system.
2. Install NI LabVIEW.

Refer to the LabVIEW Installation Guide for installation instructions for LabVIEW and
system requirements for LabVIEW software. Refer to the LabVIEW Upgrade Notes for
additional information about upgrading to the most recent version of LabVIEW for
Windows.

3. (Optional) Install NI LabVIEW FPGA Module.

Refer to the LabVIEW FPGA Module Release and Upgrade Notes for installation
instructions and information about getting started with the LabVIEW FPGA Module.

Note  Installation of the LabVIEW FPGA Module is required to customize the
behavior of the device FPGA if you are using the instrument design libraries.

4. (Recommended) Install the latest service pack for LabVIEW and any LabVIEW modules
you are using.

5. Visit ni.com/downloads/drivers and search for the following:
• NI-SCOPE
• LabVIEW Instrument Design Libraries for Reconfigurable

Oscilloscopes
6. Download the latest versions of NI-SCOPE and/or LabVIEW Instrument Design

Libraries for Reconfigurable Oscilloscopes, extract the downloaded files, and run the
executable (.exe) file(s).
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Driver support for the PXIe-5164 was first available in NI-SCOPE 16.1 and
NI LabVIEW Instrument Design Libraries for Reconfigurable Oscilloscopes 16.1.

7. Follow the instructions in the installation prompts to install the default installation.

Windows users may see access and security messages during installation. Accept the
prompts to complete the installation.

Note  For troubleshooting information, contact NI technical support or visit 
ni.com/support.

8. When the installer completes, restart your system.

Installing the PXIe-5164

Notice  To prevent damage to the PXIe-5164 caused by ESD or contamination,
handle the module using the edges or the metal bracket.

You must install the software before installing the hardware.

Before you install the hardware, refer to the guidelines in the Maintain Forced-Air Cooling
Note to Users included with the module to ensure that the device can cool itself effectively.
This document is also available at ni.com/manuals.

The PXIe-5164 is a single-slot module with one backplane connector. The module may be
installed into any PXI Express-compatible slot.
1. Ensure the AC power source is connected to the chassis before installing the module.

The AC power cord grounds the chassis and protects it from electrical damage while you
install the module.

2. Power off the chassis.
3. Inspect the slot pins on the chassis backplane for any bends or damage prior to

installation. Do not install a module if the backplane is damaged.
4. If the chassis has multiple fan speed settings, ensure the fans are set to the highest setting.

Note  Inadequate air circulation could cause the temperature inside the chassis
to rise above the optimal operating temperature for the device, potentially
causing thermal shutdown, shorter lifespans, or improper performance.

5. Position the chassis so that inlet and outlet vents are not obstructed.

For more information about optimal chassis positioning, refer to the chassis
documentation.

6. Remove the black plastic covers from all the captive screws on the module front panel.
7. Identify a supported slot in the chassis. The following figure shows the symbols that

indicate the slot types.
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Figure 2. Chassis Compatibility Symbols

NI PXIe-1062Q
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1. PXI Express System Controller Slot

2. PXI Peripheral Slot

3. PXI Express Hybrid Peripheral Slot

4. PXI Express System Timing Slot

5. PXI Express Peripheral Slot

PXIe-5164 modules can be placed in PXI Express peripheral slots, PXI Express hybrid
peripheral slots, or PXI Express system timing slots.

8. Touch any metal part of the chassis to discharge static electricity.
9. Ensure that the ejector handle is in the downward (unlatched) position.
10. Place the module edges into the module guides at the top and bottom of the chassis. Slide

the module into the slot until it is fully inserted.

Figure 3. Module Installation
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1. System Controller

2. Chassis

3. Power Switch

4. Module Guides

5. Hardware Module

6. Front-Panel Mounting Screw
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11. Latch the module in place by pulling up on the ejector handle.
12. Secure the module front panel to the chassis using the front-panel mounting screws.

Note  Tightening the top and bottom mounting screws increases mechanical
stability and also electrically connects the front panel to the chassis, which can
improve the signal quality and electromagnetic performance.

13. Cover all empty slots using EMC filler panels or fill using slot blockers to maximize
cooling air flow, depending on your application.

14. Power on the chassis.

Related Information

Why Is the ACCESS LED Off When the Chassis Is On? on page 20
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PXIe-5164 Front Panel and Pinout

Front Panel

PXIe-5164

400  MHz Oscilloscope

ACCESS ACTIVE

CH 0

CAT II TO

50 Ω: 5 V Peak MAX

1 MΩ: 250 V Peak MAX

CH 1

250 V RMS
MAX INPUT:

+5 V MAX

CLK

IN
PFI 0

AUX 0
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Table 4. Connectors

Signal Connector Type Description

   CH 0 and CH 1 BNC female Analog input connection; digitizes data and triggers
acquisitions.

CLK IN SMB Imports an external reference clock or sample clock to
the oscilloscope.

PFI 0 SMB PFI line for digital trigger input/output, probe
compensation.

AUX 0 MHDMR Reference clock input, reference clock output,
bidirectional digital PFI, and 3.3 V power output.

Table 5. Access LED

Color Indications

  Off The module is not yet functional or the module has detected a problem with a power
rail.

Amber The module is being accessed.

Green The module is ready to be programmed.

Table 6. Active LED

Color Indications

  Off Module is not armed, triggered, or acquiring a waveform.

Amber The module is armed and waiting for a Reference (Stop) Trigger.

Green The module has received a Reference (Stop) Trigger. Also indicates that the module
is acquiring a waveform.

Red The module has detected an error. The LED remains red until the error condition is
removed. The following scenarios are examples of potential errors:
• Detected an unlocked condition on a previously locked PLL. A PLL that is

unlocked while in reset does not show an error.
• Unable to detect the external sample clock.
• Detected an overheating or overpowering error.

Note  Certain driver interactions may cause the Active LED to flash red.
An error condition does not exist unless the Active LED remains red.
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AUX 0 Connector Pinout
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Table 7. AUX 0 Connector Pin Assignments

Pin Signal Signal Description

   1 GND Ground reference for signals

2 CLK IN Used to import an external reference clock

3 GND Ground reference for signals

4 GND Ground reference for signals

5 CLK OUT Used to export the reference clock

6 GND Ground reference for signals

7 GND Ground reference for signals

8 AUX 0/PFI 0 Bidirectional PFI line

9 AUX 0/PFI 1 Bidirectional PFI line

10 GND Ground reference for signals

11 AUX 0/PFI 2 Bidirectional PFI line

12 AUX 0/PFI 3 Bidirectional PFI line

13 GND Ground reference for signals
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Table 7. AUX 0 Connector Pin Assignments (Continued)

Pin Signal Signal Description

   14 AUX 0/PFI 4 Bidirectional PFI line

15 AUX 0/PFI 5 Bidirectional PFI line

16 AUX 0/PFI 6 Bidirectional PFI line

17 AUX 0/PFI 7 Bidirectional PFI line

18 +3.3 V +3.3 V power (200 mA maximum)

19 GND Ground reference for signals

PXIe-5164 SCB-19 Pinout
You can use the SCB-19 connector block to connect digital signals to the AUX 0 connector on
the PXIe-5164 front panel. Refer to the following figure and table for information about the
SCB-19 signals when connected to the AUX 0 front panel connector.

1 2 3 4 5 6 7 8 9 10

14 15 16 17 18 19 20 21 22 23

11 12 13

24 25 26

Table 8. SCB-19 Signal Descriptions

Pin Signal Signal Description

   1 PFI 0 Bidirectional PFI line

2 PFI 1 Bidirectional PFI line

3 PFI 2 Bidirectional PFI line

4 PFI 3 Bidirectional PFI line

5 NC No connection

6 CLK IN Used to import an external reference clock or sample clock
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Table 8. SCB-19 Signal Descriptions (Continued)

Pin Signal Signal Description

   7 NC No connection

8 CLK OUT Used to export the reference clock

9 PFI 4 Bidirectional PFI line

10 PFI 5 Bidirectional PFI line

11 PFI 6 Bidirectional PFI line

12 PFI 7 Bidirectional PFI line

13 +3.3 V +3.3 V power (200 mA maximum)

14 to 26 GND Ground reference for signals

PXIe-5164 Mini-HDMI Breakout Cable to 6 BNC Pinout
You can use the Mini-HDMI Breakout Cable to 6 BNC to connect digital signals to the AUX 0
connector on the PXIe-5164 front panel. Refer to the following figure and table for
information about the Mini-HDMI Breakout Cable to 6 BNC signals when connected to the
AUX 0 front panel connector.

PFI 1

CLK IN

PFI 0

CLK OUT

PFI 2

PFI 3
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Table 9. Mini-HDMI Breakout Cable to 6 BNC Signal Descriptions

Signal Connector Type Description

   CLK IN

BNC female

Used to import an external reference clock

CLK OUT Used to export the reference clock

PFI 0 Bidirectional PFI line

PFI 1 Bidirectional PFI line

PFI 2 Bidirectional PFI line

PFI 3 Bidirectional PFI line

Configuring the PXIe-5164 in MAX
Use Measurement & Automation Explorer (MAX) to configure your NI hardware. MAX
informs other programs about which NI hardware products are in the system and how they are
configured. MAX is automatically installed with LabVIEW Instrument Design Libraries for
Reconfigurable Oscilloscopes.

MAX in also installed with NI-SCOPE.
1. Launch MAX.
2. In the configuration tree, expand Devices and Interfaces to see the list of installed NI

hardware.

Installed modules appear under the name of their associated chassis.
3. Expand your Chassis tree item.

MAX lists all modules installed in the chassis. Your default names may vary.

Note  PXIe-5164 modules appear as NI-RIO devices in the list. If you do not
see your module listed, press <F5> to refresh the list of installed modules. If the
module is still not listed, power off the system, ensure the module is correctly
installed, and restart.

4. Record the identifier MAX assigns to the hardware. Use this identifier when
programming the PXIe-5164.

Note  When you install, uninstall, or move an NI-RIO device in your system,
resource identification of your NI-RIO devices may change. Whenever any of
these changes occur, verify resource identification for all your NI-RIO devices
in MAX and, if necessary, make changes to your software and documentation.

5. Self-test the hardware by selecting the item in the configuration tree and clicking Self-
Test in the MAX toolbar.
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The MAX self-test performs a basic verification of hardware resources.

Related Information

What Should I Do if the PXIe-5164 Doesn't Appear in MAX? on page 21

PXIe-5164 Self-Calibration
For the PXIe-5164, self-calibration yields the following benefits:
• Characterizes onboard sample clock phase adjustment circuitry
• Characterizes onboard intermodule synchronization measurement circuitry
• Corrects for DC gain and offset errors within the oscilloscope for all ranges and both

input impedance paths based on comparison to a precision, high-stability internal voltage
reference

• Calibrates offset error of interleaving ADCs
• Takes approximately 1 minute to complete

Running Self-Calibration
Running self-calibration enables the PXIe-5164 to yield full performance over its operating
temperature range and two-year external calibration cycle.

Before running self-calibration, warm up the PXIe-5164 for at least 15 minutes.

Note  Warm-up begins after the chassis and controller or PC is powered, the
module is recognized by the host, and the module is configured using the instrument
design libraries or NI-SCOPE.

Tip  In some RIO applications, the power consumed by the module can be
significantly higher than the default image for the module. In these cases, you can
improve performance by loading your image and configuring the PXIe-5164 before
warm-up time begins.

PXIe-5164 modules are externally calibrated at the factory, but for optimal performance, use
self-calibration in any of the following situations:
• After first installing the PXIe-5164 in your chassis
• After any module in the chassis is installed, uninstalled, or moved
• When the system is in an environment where the ambient temperature varies or the

module temperature has drifted more than ±5 °C from the previous self-calibration
• To periodically adjust for small performance drifts that occur with product aging
• When 90 days have elapsed since the previous self-calibration

Tip  You can use the nodes on the LabVIEW Instrument Design Libraries for
Reconfigurable Oscilloscopes External Calibration palette to programmatically
return the date and module temperature of the previous self-calibration. You can also
view this information by selecting the device in MAX.
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Self-calibrate the PXIe-5164 programmatically in NI-SCOPE/LabVIEW Instrument Design
Libraries for Reconfigurable Oscilloscopes or on demand in MAX.

Option Description

  NI-SCOPE, LabVIEW
Instrument Design Libraries
for Reconfigurable
Oscilloscopes

Use the Self Calibrate node to self-calibrate the module.

MAX Select the device in the Devices and Interfaces menu
and click the Self-Calibrate button.

When the two-year external calibration interval expires, an external calibration is required to
ensure performance that is within specification over the subsequent two years.

Related Information

What Should I Do if the PXIe-5164 Fails the Self-Test or Self-Calibration? on page 21

First Measurements

Making a Measurement with InstrumentStudio
1. Connect CH 0 to an input signal.
2. Launch InstrumentStudio at Start»National Instruments.
3.

In the instrument header menu in the upper-right corner of the panel ( ), add the
PXIe-5164 to the large panel with Add/Remove Devices.

4. Click Auto to automatically configure device settings for the detected signal.
5. If the soft front panel is not already running, click Run/Stop.
6. Add oscilloscope measurements to the channel by selecting Add/Remove in the

measurement table of the oscilloscope.

For more information on the measurements available for oscilloscopes in InstrumentStudio,
refer to the InstrumentStudio Manual at ni.com/manuals.

Making a Measurement with LabVIEW
1. Launch LabVIEW.
2. Select Help»Find Examples.
3. Open the example VI that you want to use by selecting Hardware Input and Output»

Modular Instruments»NI-SCOPE (High-Speed Digitizers).

Tip  If you are not sure which example to run, use the Quick Start VI, which is
found under Hardware Input and Output»Modular Instruments»NI-
SCOPE (High-Speed Digitizers)»Demos»niScope EX Quick Start.vi.
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4. Follow any setup instructions in the VI and specify any desired settings.
5. Click Run to run the example program.

Making a Measurement with Instrument Design

Libraries
You can verify proper installation and configuration of your device by making a measurement
using the instrument design libraries within a LabVIEW sample project.

This measurement requires installation of the instrument design libraries.
1. Launch LabVIEW.
2. Select File»Create Project.
3. On the left side of the Create Project window, select Oscilloscopes.
4. On the right side of the Create Project window, select the Stream to Host (PXIe-5164)

sample project and click Next.
5. Specify a name, location, and device target for the project in the Create Project window

and click Finish.
6. Depending on your LabVIEW bitness, open the .html file at either of the following

default paths and navigate to the Running this Sample Project section of the file.

Option Description

  32-bit LabVIEW C:\Program Files (x86)\National Instruments
\LabVIEW [year]\ProjectTemplates\Source\Digtzr
\Stream To Host (NI 5164)\documentation

64-bit LabVIEW C:\Program Files\National Instruments\LabVIEW
[year]\ProjectTemplates\Source\Digtzr\Stream To
Host (NI 5164)\documentation

7. Follow the instructions in the project documentation for making the measurement.

PXIe-5164 Compensating Passive Probes
Compensating passive probes increases the accuracy of your measurements by matching the
capacitance of your probe to the capacitance of a particular oscilloscope input channel.

Before beginning this procedure, complete the following:
• Set up your oscilloscope in a compatible chassis;
• Install a version of LabVIEW Instrument Design Libraries for Reconfigurable

Oscilloscopes compatible with your oscilloscope on your system; and
• Configure a panel and layout in InstrumentStudio to include your oscilloscope.

Note  For more information on using InstrumentStudio, refer to the
InstrumentStudio Manual at ni.com/manuals.

The following equipment is required for this procedure:
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If using the Oscilloscope Probe
Compensator

• Oscilloscope Probe Compensator (NI part number
786983-01)

If connecting the probe directly to
the oscilloscope PFI

• A 50 Ω SMB (f)-to-BNC (f) cable, such as the
SMB-100 (NI part number 781449-01)

• A probe tip–to-BNC (m) adapter

The PXIe-5164 can output a 1 kHz square wave that you can use to compensate passive
probes.

To compensate a passive probe, complete the following steps:
1. Connect the BNC end of the probe to an input channel of your oscilloscope.
2. Depending on your connection method, connect the probe tip to the oscilloscope:

• Oscilloscope Probe Compensator
1. Connect the SMB end of the Oscilloscope Probe Compensator to the PFI

connector of the oscilloscope that generates the probe compensation signal.
2. Connect the ground clip of the probe to the ground terminal.
3. Contact the tip of the probe to the square wave terminal.

• Direct connection to PFI
1. Connect the SMB end of the SMB (f)-to-BNC (f) cable to the PFI connector of

the oscilloscope that generates the probe compensation signal.
2. Attach the BNC adapter to the tip of the probe.
3. Connect the probe tip via the BNC adapter to the BNC end of the cable.

3. Enable the probe compensation signal:

Option Description

  InstrumentStudio
In the instrument header menu ( ) in the upper-right corner of
the panel, select Probe Compensation»Enabled.

NI-SCOPE Call Probe Compensation Signal Start.

4. In InstrumentStudio, configure the settings of the input channel to which you connected
the probe.
a) Set the channel to On to display the signal.
b) Set the Input impedance of the channel to 1 MΩ.
c) Match the Probe attenuation setting to the setting on your probe.

5. Adjust the vertical range on the input channel until the signal starts to clip and then
increase the vertical range by one step so that it no longer clips.

This process ensures you are using the maximum dynamic range of the ADC.
6. Examine the digitized signal and adjust the tunable capacitor on the probe.

The probe is correctly compensated when the waveform appears as square as possible:
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Probe Adjustment Signal Probe Adjustment Signal Probe Adjustment Signal

Compensated Correctly Undercompensated Overcompensated

Proper Amplitude of a

1 MHz Test Signal

Reduced Amplitude of a

1 MHz Test Signal

Increased Amplitude of a

1 MHz Test Signal

Once compensated, the probe conveys signals to the input channel accurately, without
artificially attenuating or amplifying frequency components of the signal.

Tip  For the most accurate measurements:
• Compensate probes for each channel of the oscilloscope;
• Use a compensated probe only with the channel you used to compensate it; and
• Compensate your probes frequently.

Troubleshooting
If an issue persists after you complete a troubleshooting procedure, contact NI technical
support or visit ni.com/support.

Why Is the ACCESS LED Off When the Chassis Is

On?
The LEDs may not light until the module has been configured in MAX. Before proceeding,
verify that the PXIe-5164 appears in MAX.

If the ACCESS LED fails to light after you power on the chassis, a problem may exist with the
chassis power rails, a hardware module, or the LED.

Notice  Apply external signals only while the PXIe-5164 is powered on. Applying
external signals while the module is powered off may cause damage.

1. Disconnect any signals from the module front panels.
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2. Power off the chassis.
3. Remove the module from the chassis and inspect it for damage. Do not reinstall a

damaged module.
4. Install the module in a different chassis slot from which you removed it.
5. Power on the chassis.

Note  If you are using a PC with a device for PXI remote control system,
power on the chassis before powering on the computer.

6. Verify that the module appears in MAX.
7. Reset the module in MAX and perform a self-test.

What Should I Do if the PXIe-5164 Doesn't Appear in

MAX?
1. In the MAX configuration tree, expand Devices and Interfaces.
2. Expand the Chassis tree to see the list of installed hardware, and press <F5> to refresh

the list.
3. If the module is still not listed, power off the system, ensure that all hardware is correctly

installed, and restart the system.
4. Navigate to the Device Manager.

Operating System Description

  Windows 10/8.1 Right-click the Start button, and select Device Manager.

Windows 7 Select Start»Control Panel»Device Manager.

5. Verify the PXIe-5164 appears in the Device Manager.
a) Under an NI entry, confirm that a PXIe-5164 entry appears.

Note  If you are using a PC with a device for PXI remote control system,
under System Devices, also confirm that no error conditions appear for the
PCI-to-PCI Bridge.

b) If error conditions appear, reinstall LabVIEW Instrument Design Libraries for
Reconfigurable Oscilloscopes and the PXIe-5164.

What Should I Do if the PXIe-5164 Fails the Self-Test

or Self-Calibration?
1. Restart the system.
2. Launch MAX, and perform the self-test or self-calibration again.
3. Power off the chassis.
4. Reinstall the failed module in a different slot.
5. Power on the chassis.
6. Perform the self-test or self-calibration again.
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Where to Go Next
After you have installed your hardware, configured the module in MAX, and taken a basic
measurement, you can begin programming your hardware using the instrument design
libraries, NI-SCOPE, or custom logic. Refer to the following list for resources and information
that you may need as you create your application.

*This item is also installed with the driver software.
†Device information is also located in the NI High-Speed Digitizers Help.

NI PXIe-5164

EXPLORE LEARN CREATE

DISCOVER

Located online at ni.com/manuals

LabVIEW FPGA

Module Help

Getting Started with

LabVIEW

the application development

environment (ADE)

 for your application.

about hardware features 

or review device  

specifications.

custom applications with

an application programming

interface (API).

NI Reconfigurable

Oscilloscopes Help*†

PXIe-5164

Specifications
Instrument Design Libraries for

Reconfigurable Oscilloscopes

Sample Projects*

NI-SCOPE

NI-SCOPE Examples*

Services

ni.com/services

Support

ni.com/support

more about your products through ni.com. 

Updates

ni.com/updates

NI Oscilloscopes

ni.com/digitizers

NI High-Speed
Digitizers Help

Use this help file to learn how to operate the PXIe-5164 using the
NI-SCOPE soft front panel and device driver. This help file also
includes device information and programming information.

NI Reconfigurable
Oscilloscopes Help

Use this help file to learn how to operate the PXIe-5164 using
instrument design libraries. This help file also includes device
information and programming information.
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Worldwide Support and Services
The NI website is your complete resource for technical support. At ni.com/support, you have
access to everything from troubleshooting and application development self-help resources to
email and phone assistance from NI Application Engineers.

Visit ni.com/services for information about the services NI offers.

Visit ni.com/register to register your NI product. Product registration facilitates technical
support and ensures that you receive important information updates from NI.

NI corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas,
78759-3504. NI also has offices located around the world. For support in the United States,
create your service request at ni.com/support or dial 1 866 ASK MYNI (275 6964). For
support outside the United States, visit the Worldwide Offices section of ni.com/niglobal to
access the branch office websites, which provide up-to-date contact information.
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Information is subject to change without notice. Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for

information on NI trademarks. Other product and company names mentioned herein are trademarks or trade names of their

respective companies. For patents covering NI products/technology, refer to the appropriate location: Help»Patents in your

software, the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents. You can find

information about end-user license agreements (EULAs) and third-party legal notices in the readme file for your NI product. Refer

to the Export Compliance Information at ni.com/legal/export-compliance for the NI global trade compliance policy and how

to obtain relevant HTS codes, ECCNs, and other import/export data. NI MAKES NO EXPRESS OR IMPLIED WARRANTIES AS

TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND SHALL NOT BE LIABLE FOR ANY ERRORS. U.S.

Government Customers: The data contained in this manual was developed at private expense and is subject to the applicable

limited rights and restricted data rights as set forth in FAR 52.227-14, DFAR 252.227-7014, and DFAR 252.227-7015.
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